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*********************************************************************** 

Revision history Ver1.06 -> Ver1.07 

*********************************************************************** 

 

- Added multipage for folder thumbnail 

- Implemented fast thumbnail browsing 

- Added OLE support 

- Fixed some bugs and applied minor improvements 

 

 

====================================== 

Multipage for folder thumbnail 

====================================== 

 

The thumbnail window is useful for managing your picture resources. With MMSSTV 1.07, you can view the pictures stored in two or 

more different folders in one thumbnail window. 

 

To open the thumbnail window, click on "View" and select "Always show thumbnails of files folder." Right click on any thumbnail in 

the thumbnail window and select "Options" and "Create new page." Select the folder that you want to add the thumbnail window. You 

will find a new tab added at the top of the window. If you want to change the tab name, select "Options" and "Rename page." The 

window can have up to 10 pages. 

 

 

================================== 

Fast thumbnail browsing 

================================== 

 

If the size of the picture or template is large, it should take substantial time to load and show all the thumbnail images in the folder 

thumbnail window. To get the load and show operation faster, MMSSTV version 1.07 makes an index of the thumbnails once while 

loaded. MMSSTV uses the index for the next time on for faster thumbnail browsing. 

 

MMSSTV creates the index in the FIndex folder under the MMSSTV directory. The index contains the view information and the 

thumbnail bitmaps. The index uses some disk spaces, but it significantly saves the memory and resources. 

 

If you do not want to make the index, right click on the thumbnail, select "Options" and uncheck "Fast access with index." MMSSTV 

does not make the index as version 1.06 or earlier. You can individually enable or disable this indexing feature for each folder. 

 

* MMSSTV does not generate any file in the referred folders. 

 

=============== 

OLE support 

=============== 

 

MMSSTV now supports OLE (Object Linking and Embedding). If the object is embedded (or linked) in the template, you can make 

use of the various functions offered in the object. 

 

* Object means the whole or some part of the document in another application. 



 

* What kind of object can you utilize in MMSSTV? It is dependent on the OLE application you have. If you have installed a word 

processor, for example, you can use the word processor document as well as all the functions, such as character effect and picture 

drawing, provided in the word processor. 

 

 

1. Object embedding 

 

To embed an object in the template, use one of the following five methods. 

 

- Right click on the template window of MMSSTV, select Object -> Insert, and make a new object to embed. You can embed the 

existing file or place a link to it in the template, too. 

 

- Make an object in the other application and copy it to the clip board. Right click on the template window of MMSSTV, and select 

Object -> Paste. 

 

- Drag and drop the target object file from Explorer or My computer to the MMSSTV template. It should be noted, however, that BMP, 

JPG, WMF, MTM, MTI and DLL files are not embedded as an OLE object. 

 

- Open the folder thumbnail window (View -> Always show thumbnails of files folder), and right click on the target picture in the 

window. Select "Embed to Template as OLE." In this case, the embedded picture always becomes a bitmap OLE. 

 

- Open the thumbnail folder as the OLE object type and double click the target thumbnail. You can use drag&drop, too. 

 

2. Object editing 

 

To edit the embedded object, just double click it. Another way to do this is keep the object selected and push the Set color button. If 

you cannot start the server application, right click on the target object and select Object -> Edit. 

 

The server application of the embedded object works as the editor. Please refer to the help file of the server application. For example, 

Windows Paint is invoked for the target application when a BMP file is double clicked. 

 

3. Object displaying and resizing 

 

MMSSTV displays the object in the overlay mode. If you do not want to get the background transparent, right click on the object, select 

Object, and uncheck Overlay. 

 

When "Object" -> "Strech as bitmap" is checked, MMSSTV uses a bitmap resizing code instead of a metafile resizing code. Generally 

speaking, the metafile resizing code gives better results for the characters with special effect. The bitmap resizing code, on the other 

hand, gives better result for image objects like photographs. 

 

4. Custom item 

 

If you are not satisfied with the MMSSTV graphic tools or the OLE functions, you can embed a custom item that you have created by 

yourself. 

 

To embed a custom item, go with "Object" -> "Insert custom item," and select the target item. Another way to do this is to open the 

folder thumbnail as Custom item type and double click the target thumbnail (or drag & drop it to the template). 

 

For the implementation of the custom item, refer to ECUSTOM.TXT, which is included in the PerImg package. 

 

 

73, Mako 
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*********************************************************************** 

Revision history Ver1.05 -> Ver1.06 

*********************************************************************** 

 

- Added VFO polling for JRC JST-245 

- Supported the slash zero in Hangul font 

- Added several SSTV modes 

- Improved the automatic synchronization function 

- Had the timing of the B/W 8-sec mode adjusted to Robot 1200C 

- Added a special font manipulation for East Asian languages 

- Added customizable VOX tone 

- Took measures not to lost sound 

- Added RTS control for muting audio while receiving a picture 

- Added overlay function 

- Fixed some bugs and applied minor improvements 

================================== 

Special font manipulation for East Asian languages 

================================== 

 

Version 1.06 has a special font manipulation for East Asian languages. In case you want to use a new language that is different from 

your default one, you must install the font and code page of the new one. If you have only the font installed, you might encounter 

problems in several operations including vertical unfolding. 

 

MMSSTV treats the codepages of the following languages in a special manner: 

932    Japanese    Verified 

949   Hangul   Verified 

950   Chinese (BIG5) Not verified 

936   Chinese (GB2312)  Not verified 

======== 

Sound lost 

======== 

 

I have figured out that some soundcards are likely to lose sound, which results in synchronization drift. I have added a code to try fixing 

the problem. It is effective in some degree, but does not completely solve the problem. I recommend you to install the latest device 

driver of your soundcard. 

 

If you still have the problem, try turning off LoopBack in the TX page and increasing the FIFO depth in the Misc page. 

 

============== 

MP/MR/ML modes 

============== 

 

MP mode: It is based on the color difference scheme that the PD mode uses. This mode should be useful for reducing multi-path 

distortion and jitter. The scan time for each pixel is longer than the other modes, but the color information along the vertical axis is 

compressed. 

 



MR/ML mode: It is based on the color difference scheme that the Robot 24/72 mode uses. This mode is aimed for offering good 

resolution in good condx. The color information along the horizontal axis is compressed. 

 

These modes are not new to SSTV actually, but I have added them by way of trial. In particular, I have considered good trade-off 

between the transmission time, picture size, and quality. As a new trial, the VIS signal is expanded to 16 bits. Refer to Mode.txt for the 

details of the new modes and their VIS format. 

 

============ 

B/W 8-sec mode 

============ 

 

Changing with times including the old monochrome generation, the B/W 8-sec mode seems to have several "dialects" in terms of the 

aspect ratio and the timing. 

MMSSTV has adjusted the timing to the Robot 1200C scan converter, which is used as the standard of the VIS signals. When you 

come across a picture with different timing, turn Auto slant on or push the niconico mark button in the Sync window. 

 

================ 

RTS control while scan 

================ 

 

I have added "RTS while scan" option in the MMSSTV Setup window. The behavior of the COM port signals, that is, DTR, RTS, and 

TXD can be selected as follows: 

  [RTS while scan = OFF] 

  RX         TX SCAN (receiving a picture) 

  DTR  OFF ON OFF 

  RTS  OFF ON  OFF 

  TXD  ---   ---  --- (no control) 

    

  [RTS while scan = ON] 

  RX  TX  SCAN (receiving a picture) 

  DTR   OFF  ON  OFF 

  RTS OFF ON ON 

  TXD NoBreak NoBreak Break 

 

======== 

VOX tone 

======== 

 

If you use the COM port to switch PTT or if you have a responsive VOX interface, you can eliminate the VOX tone, which is sent 

before the picture. Select "User defined" in the VOX tone pane on the TX page of Setup MMSSTV. Push Edit button and delete all the 

definitions. MMSSTV no longer generates the tone for triggering VOX prior to sending a picture. 

 

 

 

 



====================== 

Overlay (superimpose) function 

====================== 

 

In the template, you can place an image that is superimposed on the TX picture. By using an image that has a uniform background 

color, such as an illustration, you would be able to make amusing effects on your picture. 

 

In the image, all the pixels that have the transparent color are transparent, that is, invisible on the TX picture. The transparent color is 

defined by the color of the transparent point in the image. The default position of the transparent point is the upper left corner of the 

image. 

 

Here is a sample procedure to use the overlay function. In the template window, push Draw picture button (a small button whose face 

has the sun and mountains), and draw a rectangle that specifies the image size and position in the template window. You should have 

the Choose picture window popped up. Select Overlay in the source pane, and load an image. Left click on somewhere in the picture. 

The clicked point is the new transparent point, that is, the color of the point becomes the new transparent color. Try right clicking 

somewhere in the image. All the pixels that have the same color of the clicked point are changed to the current transparent color. 

 

If the source image is stored in the JPEG format, the background color is not always uniform owing to the image compression effect. 

This results in color leak in the overlay image. In such a case, try using the color smoothing function, which is available at the right side 

of the Choose picture window, in order to alleviate the color leak. 

 

When the size of the overlay image is changed in the template window, MMSSTV gives priority to the color smoothness over the 

image quality. If the image quality is degraded, change the size of the image in the bitmap format, and then convert it to the overlay 

image. The size change in the bitmap format, however, gives priority to the image quality, and thus it would degrade the color 

smoothness. In this case, try using the color smoothing function to alleviate the color leak. 

 

*********************************************************************** 

Revision history Ver1.04 -> Ver1.05 

*********************************************************************** 

- Added two window layouts 

- Added an optional window for the control buttons 

- Added an option that attaches the RX window to the WINDOWS desktop. 

- Added double-click short-cut operations for the stocked pictures, stocked templates,  

   folder thumbnails. 

- Added 320x240 image manipulating schemes 

- Added a repeater function 

- Fixed a bug that caused the resource shortage in Windows 95/98/ME 

- Fixed some bugs and applied minor improvements 

 

============ 

Window layouts 

============ 

You can select one of three window layouts by clicking "View" and selecting "Design." 

 

[Standard] 

This is the conventional MMSSTV window layout. All the information is shown in one window. 

 

[Separate stock view] 

The stock window is detached from the main window. 

 

[Separate all views] 

All the windows are separated. 

 

Each detached window can be moved and resized independently. 

 



================= 

Control buttons window 

================= 

Click on "View" and select "Always show control buttons" to open an optional window dedicated to the control buttons. 

 

[Stop RX] 

Stop the RX operation immediately and go into the stand-by state (Auto). 

 

[ReSync] 

Make the synchronization again. 

 

[Lock RX] 

When the button is depressed, MMSSTV turns off "Auto stop" and "Auto restart," and therefore it won't stop the RX scan even in QRM 

and/or QSB. When the button is not depressed, "Auto stop" and "Auto restart" are resumed. 

 

[CopyHist] 

If the RX image is not copied to the history, press this button to force the copy. 

 

[TX(F9)] 

It functions just same as the TX button of the TX window. You can use F9 key to switch TX/RX. 

 

====================================== 

Attaching the RX window to the WINDOWS desktop 

====================================== 

When you have activated "Always show RX viewer" option, you can attach the window to the WINDOWS desktop. Right click the RX 

window and select "Child of a desktop window" in the pop-up menu. 

In this mode, the RX viewer remains active, even if the main MMSSTV window is minimized.  

 

==================== 

320x240 image manipulation 

==================== 

Click on "Edit" and select "Handling of 320x240" to settle how to manipulate 320x240 image sources. This selection is also applied to 

the combination of the 640x480 source and 640x496 TX images. 

 

[Vertical stretching] 

The image is vertically stretched. The image aspect ratio is not reserved. 

 

[Auto stretching] 

The image is horizontally and vertically stretched. The aspect ratio is reserved. The original image slightly loses the left and right 

edges. This is the operation that MMSSTV used in the earlier versions. 

 

[No stretching] 

The image size is unchanged. The TX image has 16 vacant lines at the bottom. 

 

[Shift picture for the header] 

The image size is unchanged. The TX image has 16 vacant lines at the top for the header. 

 

It should be noted that this manipulation does not work for the image that derived through the image clipper. 

 

================ 

SSTV repeater function 

================ 

MMSSTV can work as an SSTV repeater. Refer to Repeater.txt for details. 

 

 



*********************************************************************** 

Revision history Ver1.03 -> Ver1.04 

*********************************************************************** 

- Improved the user interface for the character input in the template 

- Added perspective and 3-D effects for the template text 

- Corrected some bugs and applied minor improvements 

 

*********************************************************************** 

Revision history Ver1.02 -> Ver1.03 

*********************************************************************** 

- Added "FFT demodulator" mode in the spectrum display 

- Added AFC 

- Added Undo in the pop-up menu for the template 

- Corrected some bugs and applied minor improvements 

 

============= 

Spectrum display 

============= 

The user can select one of "OFF," "FFT," or "FM demodulator" mode for the spectrum display. The default has been set to FM 

demodulator. If you want to use the conventional FFT mode, change back it to "FFT." 

 

* If you draw CMT-HELL, which was made by PY4ZBZ, in the waterfall of MMSSTV,  

   you must select "FFT." 

 

The FM demodulator uses another wide-band FM demodulator in addition to the picture demodulator. It draws the chart as the function 

of the rate of incidence at each frequency. Because its computation process is much simpler than the FFT, it gives good response even 

to the short pulse like a synchronization signal, but it does not reflect the signal level. 

 

The FFT and FM demodulator observe the signal before the SSTV BPF in order to see the signals outside of the BPF, too. 

 

--- Sound in --+--> SSTV demodulator 

| 

---> Spectral (FFT / FM demodulator) 

 

==== 

AFC 

==== 

AFC is activated by pushing the AFC button in the DSP pane on the main window.  

The default is ON. 

 

When AFC is locked to the signal, the triangle marker on the synchronization frequency line is displayed in blue. When AFC is 

unlocked, the triangle marker is displayed in red. During in red, the response to the frequency discrimination becomes slow. 

 

* The AGC in the previous versions was deleted because it seemed to offer no improvements. 

 

*********************************************************************** 

Revision history: Ver1.01 -> Ver1.02 

*********************************************************************** 

- Added the Hilbert transform method in the FM decoder 

- Improved the processing speed of the low-level sound processing 

- Added the TX-offset button on the Sync window 

- Added High-accuracy slant adjustment method 

- Added Vari-SSTV function 

- Debugged the automatic start function 

- Corrected some bugs and enhanced some functions 



 

================================== 

Added Hilbert transform method in the FM decoder 

================================== 

The figure below shows the flow of the Hilbert transform decoder.  

This idea was given by JA6UHL Nishimura-san (MNI TNX to JA6UHL). 

 

--+> Delay(N) -> Real 

| |==> ATAN --> Differentiator --> LPF --> Pic. data 

--> FIR(2N) --> Image 

 

================ 

Low-level sound buffer 

================ 

I enhanced the sound buffer processing. You can set the FIFO sizes for TX and RX in the option menu.  

If you often loose the sound, that is, loose the synchronization, try enlarging the RX FIFO or TX FIFO. Giving higher priority to the 

sound processing is another way of alleviate the sound loosing. 

 

====================== 

High-accuracy slant adjustment 

====================== 

MMSSTV uses the least square method to solve the linear equation for analyzing the synchronization timings.  

For high quality RX signals, it will give the error less than 2ppm. 

To start the high-accuracy slant adjustment, push the NikoNiko button (comment by JA7UDE: the smiley button). You also can start it 

by right clicking on the sync or RX window and selecting High-accuracy slant adjustment in the pop-up menu. It should be noted that 

you must have received at least 16 scan lines to make this adjustment operational. The more the scan lines, the better the accuracy. 

 

================= 

Adjustment of TX offset 

================= 

Assuming that you have the RX clock calibrated, MMSSTV transmits the signal and receives it through the external loop back. 

After you have adjusted the slant (push the NikoNiko smiley button), push the TX button in the Sync window. MMSSTV automatically 

records the TX offset frequency. 

 

======== 

VariSSTV 

======== 

VariSSTV, which is proposed by Mr. Samuel Hunt, is a method to protect the final device of the TX. He says that different colors have 

different brightness and therefore making the power lower in the way shown below gives better noise immunity. 

  Sync signal  100% 

  Red   29.8% 

  Green  58.8% 

  Blue  11% 

For details, visit http://www.supersam.co.uk/sstvpwer.htm. 

 

I have no idea how it is effective. Please give it a try by yourself. Go Option, Setup MMSSTV, TX tab, and check the VariSSTV box 

under the digital output level slider. This is not operational in Robot36 or Robot72. 

 

 

 



*********************************************************************** 

Revision history Ver1.00 -> Ver1.01 

*********************************************************************** 

- Added several SSTV modes 

- Improved the image clipper function 

- Added the preview tool for selecting files 

- Fixed some bugs and improved some operations  

 

============== 

New SSTV modes 

============== 

 

The following SSTV modes have been added. 

 

Name 

                             
Time(s) Size   Method 

 ------------------------------------------------------------------ 

 
SC2-120 122 320x256  RGB 

 
SC2-60 

    

62 
320x256 RGB 

 
PD50 

    

50 
320x256 Color discrimination 

 
PD90 

    

90 
320x256 Color discrimination 

 
PD90 

    

90 
320x256 Color discrimination 

 
PD120 126 640x496 Color discrimination 

 
PD160 161 512x400 Color discrimination 

 
PD180 187 640x496 Color discrimination 

  PD240 248 640x496 Color discrimination 

  PD290 289 800x616 RGB 

 
P3 203 640x496 RGB 

  P5  305 640x496 RGB 

  P7 406 640x496 RGB 

 

To use one of these modes, click the mode button in TX or RX window with the right button of the mouse and select it from the pop-up 

menu. 

 

PD120 - PD290 and P3 - P5 have bigger image sizes than 320 x 256 (from now on, I call them high-resolution modes). The image view 

board of the MMSSTV main window is designed to show a 320x256 image. For this reason, MMSSTV shrinks and displays the images 

(resized to 320x256) in those high-resolution modes. In other words, the sizes of the actual image and that displayed in the RX window 

would not be the same. 

 

To view the high-resolution images in the original size, push the magnifier button under the RX or History window, or at the Always 

Show RX viewer, right click and select Resize to RX size in the pop up menu. 

 

To view the high-resolution TX images in the original size, push the magnifier button under the TX window. 

 

 

 



If the sizes in the TX mode and in the original image are different, MMSSTV does not resize the original image. If you want to resize 

the image, right click the TX window and select 'Stretch TX image by different size' in the pop-up menu. In this case, however, the 

image resolution sometimes degrades, particularly when you get it bigger. In addition, bear in mind that different modes have different 

aspect ratios. 

 

It is recommended that you reload the image into the TX window if you use images in different sizes. 

 

MMSSTV templates, therefore, have several sizes. It is a good idea to use the template whose size is the same as the image. In default, 

MMSSTV tries to get the template size to fit the image. However, the layout of the template components is not reserved. 

 

You can resize the template size by selecting Size entry in the pop-up menu, which appears by right clicking the Template window. If 

the size of the template is different from that of the image, MMSSTV resizes the template and gets it superimposed to the image. It 

should be noted that the quality of the template would get worse, but you can continue to use the templates that you designed in 

different sizes. 

 

The image size in the Stocked pictures is predefined as 320x256. If you want to change it, right click the Stocked pictures area and 

select Size in the pop-up menu. 

 

When you drag & drop an image from the TX window to the Stocked pictures window, MMSSTV uses the TX image size. 

 

In PD290, P5, and P7 modes, the RAM, which is used for the automatic slant adjustment, cannot store the whole image data. The slant 

and phase adjustment can be applied only to some portion of the data. To avoid this problem, select FILE for the RX buffer. 

 

======================== 

New functions in the image clipper 

======================== 

 

The following new functions have been added. 

 

- Copy and paste without changing the original image size 

- Rotate the image in 90 degrees 

- Adjust the image 

- Copy to the clipboard 

- Save an image to a file 

 

To use these functions, right click the image clipper window. You will get the pop-up menu for the functions. 

 

================= 

Preview in file selection 

================= 

 

In the dialog box for loading an image file, you can preview the image by clicking the file name. 

The preview window is appeared at the top left corner for the first time, but you can change the size and position as you like. 

 

73, Mako 

Preface 

This program is for transmitting and receiving SSTV using a PC soundcard. I was making a utility to adjust the soundcard clock for 

PSK31 programs. However, I have changed my mind, and the utility has eventually become an SSTV program. 

 

I thought that I should have made at least one SSTV QSO with this MMSSTV and then declared it as the release version 1.0. However, 

I am very busy on my own business and will have no time for amateur radio. In addition, there seem to be some people already using 

this program. At this time, I have decided to release this version as 1.00. 



 

Uninstall MMSSTV 
 

MMSSTV does not add anything to the Windows registry. 

Delete the entire directory where MMSSTV is installed. 

Main Screen 

Here is the main window in MMSSTV. I have pointed out some of the more important areas. Other windows are a level below the 

menus I have pointed out. This will at least get you started. Note that the Transmit (TX) window is also the Receive (RX) window, and 

Sync and Template and History. Depending on what tab at the top under the menus , that you currently clicked on. Makes it easy to 

switch between windows quickly. You can make up your transmit picture while receiving a picture from someone. One window will 

not interfere with any other window's function. Very handy. Also note that... 

Draft check box – if it is checked, MMSSTV draws the pictures in the stocked templates and stocked pictures windows in a DRAFT 

manner. It means that the number of colors used in the pictures is reduced. This is for saving the Windows' resources. Try making a text 

with the rainbow color. If you push the button, the text is displayed in one solid color.  

AFC (Automatic Frequency Control) button – if it is depressed, MMSSTV automatically follows the SSTV synchronization signal.  

LMS (Least Mean Square) button – if it is depressed, MMSSTV uses an adaptive filter, which is based on the LMS algorithm, for the 

RX noise reduction 

 

 



Graphics Primer - See Quick start for MMSSTV graphics Joe ( WJ5MH ) 

 

System Requirements  

OS: Windows 95, 98, 98SE, ME, NT, 2000 

Soundcard: 16-bit 11025Hz or 22050Hz 

Video adaptor: 256 or more colors  

(16- or 24-bit video adaptor is recommended) 

RAM: 32MB or more 

 

MMSSTV will run on a PC with a Pentium 100MHz, but I strongly recommend a faster CPU. 

 

The operation speed of MMSSTV is highly dependent on the performance of the video adaptor. In other words, even if two PCs have 

the same CPU, they should give different performance in accordance with the equipped video adaptor. In particular, the 256-color video 

adaptor is likely to consume more CPU power for the pallet calculation. For this reason, a 16- or 24-bit color adaptor is strongly 

recommended. 

If a 256-color video adaptor is used, the displayed colors are affected by the performance of the pallet calculation. 

 

To save the CPU power, try the following steps. 

- Increase the FIFO size of the soundcard. 

(select Option, select the Misc tab, and increase the value in the sound FIFO size) 

- Disable the RxBPF 

(select Option, select the RX tab, and check RxBPF OFF) 

- Choose RX buffer FILE or turn it off 

(select Option, select the RX tab, and check 0O0E or FILE in the RX buffer pane) 

- Turn the TX BPF off 

(select Option, select TX tab, and uncheck Tx BPF) 

 

In default, the Loopback is turned off. When it is turned on, MMSSTV performs TX and RX in parallel and increases the CPU load. 

Make sure you turn it off if your PC cannot afford to run them in parallel. 

 

--- IMPORTA0T 0OTICE ---  

The RX buffer temporarily stores the receiving or just received image to get it back to the RX window after adjusting the slant and 

phase. The buffer stores 270-second sound data, and therefore it would cause page swapping if the RAM is selected or if the physical 

memory size of your PC is not sufficient to keep the data on the memory. If you have intermittent halts during the receive operation, 

please select FILE or turn it off. 

 

The size of the receive buffer is BIG; probably bigger than you expect. If you do not use the automatic slant adjustment function, you 

should not have any operation difficulties without the receive buffer.  

 

 

 

 

 

 



Connections  

PC and radio hookup 

 

You will need to hook the computer to the radio via the soundcard. You will need two 1/8" stereo plugs. These are the same ones that 

"walkman" type radios come with. Wire the TIP of each to a shielded cord that runs to your radio's connections. A transformer or other 

type of isolation is HIGHLY recommended to keep the RF off the wires and your signal clean. Go to this excellent link to find 

interfacing diagrams for all radios. 

http://www.packetradio.com/psk31.htm 

 

PTT 

 

You can use the VOX from your radio or use a manual transmit button to transmit. The serial port will provide PTT as follows...... 

 

 

 

 

 

 



To completely isolate the computer from the radio the PTT line schematic shown above should be replaced by the following optically 

coupled circuit.  WM2U has this unit installed and it works great.  

 

 

 

 

Another interesting PTT circuit from G3VFP to cover both the RTS and/or DTR source. You can use a 2N2222 in place of the BC337 

transistor in this circuit.  

 



 

Step by Step  

To Receive a picture 

To receive a picture follow these steps.... 

• connect cables as per instructions 

• when a picture comes in it will auto start 

• if not simply click on a mode button to receive  

Manual start 

 

In case MMSSTV does not automatically start receiving or you want to start receiving not from the beginning, push one of the mode 

buttons below the Auto button. In  

JA, HL, and US, try Scottie 1. In Europe try Martin 1.  If you right click on the mode area 

you will see this menu....  

Select any one of the other modes to use it. These are generally larger format pictures 

modes. Such as 640x492.  

To Transmit a picture 

Transmission 

Ok to transmit a picture follow these steps, 

• right click on TX window 

• select Load from file... 

• browse where you have your pictures on your hard disk 

• click on a picture you want to send 

• click open 

• If the picture is larger than the tx mode you will get the picture clipper 

• you can click the max button and it will use the entire picture 

• click OK 

• your picture is now ready to transmit if you do not want to adjust it or add a template 

  

  

 

 

 

 



Logging  

MMSSTV logging utility 

 

First version - February 20, 2001 JE3HHT Makoto Mori 

Translated into English by JA7UDE Nobuyuki Oba 

 

* This document was written based on the logging utility of MMTTY. 

 

MMSSTV logging utility offers only limited functions, such as the call sign search. 

 

The current log file is the file that was most recently opened by MMSSTV. The name of the current log file is displayed at the 

MMSSTV title bar.  

The extension of the file name is  

 

To change the current log file, select "Open log file" in the File menu. Most common file name would be your_call_sign.mdt. 

 

---------- 

Basic operations 

---------- 

 

1) Input his/her call sign in the Call box of the log panel. 

2) Click the Find button to see if you have made QSO before. 

3) Call him/her. If he/she replies to you, click the QSO button. At this timing, MMSSTV records the starting time in the log. 

4) During the QSO, input other information in other boxes, such as his/her RST, my RST, and QTH. You can input more information 

by clicking the Data button. 

5) After the QSO is completed, click the QSO button again. MMSSTV records the ending time in the log. 

  

Receive  

Tone frequency 

Frequencies 

There are a few "normal" frequencies that SSTV folks like to hang out around. The 20 meter places are 14.230 and 14.233. These 

frequencies can get busy and the QRM is a bit hard to copy through sometimes. There are some frequencies up on 10M that are good 

spots as there is lots of room to move around. 28.680 is the calling frequency. There is a repeater on 28.690 operated by K3ASI on 

which you can see lots of nice pictures. Just send it a 1750 Hz tone and then it will send you back a CW "K" then send your picture.  On 

15M there is 21.340 where lots of people send pictures when the band is open. There are frequencies on 80M and 40M too. All over the 

bands you can enjoy sending pictures! 

Tone Frequencies 

SSTV's tone frequencies are defined as follows: 

Synchronization pulse 1200 Hz 

Low level of the image 1500 Hz 

High level of the image 2300 Hz 

 

There are four marker lines in the spectrum window of MMSSTV. 

From left to right: 

Green line 1200Hz Synchronization pulse 

Red  line 1500Hz Low level of the image 



Red dotted line 1900Hz Center level of the image 

Red line 2300Hz High level of the image 

 

To tune the frequency, make the signal energy be laid between the 1500Hz and 2300Hz marker lines. Alternatively, you can tune the 

receiver so that the synchronization pulses are on the 1200Hz marker line. However, the synchronization pulse is very short, so it might 

take time for you to get used to adjusting the frequency in this way. 

 

Since SSTV QSOs are made on the fixed common frequencies, you probably do not have difficulty in tuning the radio after you have 

done once. 

Auto Start 

Automatic start 

 

When the Auto button in the RX mode pane is selected, MMSSTV automatically starts the receive operation in response to the start 

trigger signal. 

 

 
 

The start trigger signal is called VIS signal, which consists of the 1200MHz marker signal and the SSTV mode code (1100Hz and 

1300Hz FSK). MMSSTV detects the signal by using a resonant FSK demodulator, and automatically starts the receive operation if it 

finds the mode supported. 

 

To automatically start receiving, MMSSTV provides another method, which measures the interval time of the synchronization pulses. If 

you do not want to use this method, go to Option, click RX tab and choose 'VIS only' in the auto start option. 

 

* Squelch 

Four levels (Lowest, Lower, Higher, and Highest) for the trigger threshold can be selected. 

Lowest makes MMSSTV trigger with the weakest signal. 

Highest makes MMSSTV trigger with the strongest signal. In other words, only the strong signal can kick off the receive operation. 

 

 

 

 

 

 

 

 

 

 



Manual Start 
 

In case MMSSTV does not automatically start receiving or you want to start receiving not from the beginning, push one of the mode 

buttons below the Auto button. In JA, HL, and US, try Scottie 1. In Europe try Martin 1. If you right click on the mode area you will 

see this menu....  

 

Select any one of the other modes to use it. These are generally larger format pictures modes. Such as 640x492.  

Auto Stop, Restart, ReSync 

Automatic stop, restart and resync 

 

When  Setup MMSSTV, RX window, auto stop,  is checked, MMSSTV automatically stops receiving in case it has lost the 

synchronization signal (this does not work in AVT90).  

 
 

When Setup MMSSTV, RX window, auto restart, is checked, MMSSTV restarts receiving from the beginning, in case it detects the 

VIS signal, even during the receive operation. It should be noted, however, that MMSSTV would not be able to detect the VIS signal 

because of the RxBPF effect. 

 

When Setup MMSSTV, RX Window,auto resync, is checked, MMSSTV automatically attempts to re-synchronize the RX image. 

This is useful if the MMSSTV has lost the synchronization during RX. 

 

However, a couple of lines are displayed with the old synchronization timing and therefore they might appear as a thin bar. 

 

 



Slant Adjustment 

 
 

MMSSTV latches the SSTV signal with respect to the soundcard clock. For this reason, you would have a slanted image if the 

soundcard clock of your PC is not correctly calibrated or if the timing of the received signal is discriminated. There are three ways to 

adjust the slant. 

 

High-accuracy slant adjustment 
 

In this method, MMSSTV uses the least square method to solve the linear equation for analyzing the synchronization timings. For high 

quality RX signals, it will give the error less than 2ppm. 

To start the high-accuracy slant adjustment, clcik the 0ico0ico button (comment by JA7UDE: the smiley button). 

 

You also can start it by right clicking on the sync or RX window and selecting "High-accuracy slant adjustment" in the pop-up 

menu. It should be noted that you must have received at least 16 scan lines to make this adjustment operational. The more the scan 

lines, the better the accuracy.     * You cannot use this method if you turn the RX buffer off. 

Automatic slant adjustment 
 

In Automatic slant adjustment, MMSSTV periodically measures the interval of the synchronization signals and automatically adjust the 

slant. When you leave this mode turned on, MMSSTV adjust the image in real time, but it gives slightly less accuracy than the High-

accuracy slant adjustment. 

 

To start this method, check the Auto slant box in the RX tab of the Setup MMSSTV menu. You also can start it by right clicking on the 

RX window and selecting Auto slant adjustment in the pop-up menu. 

 

* You cannot use this method if you turn the RX buffer off. 



Manual slant adjustment 

Click the Sync tab of the main window and do the following procedure. 

 

1) Push Slant button 

2) Click the upper right edge of the synchronization signal  

(white line) 

3) Click the lower right edge of the synchronization signal  

(same white line) 

 

The synchronization signal is displayed in a relatively fat line, so you 

must click the same side. Immediately after you click once on the line, 

a guide cursor is displayed. Adjust the cursor in parallel with the 

synchronization signal line, and click again. 

 

According to this procedure, MMSSTV recalculates the sampling clock 

of the soundcard and adjusts the receiving or just received image. If you 

do not obtain the acceptable result, repeat the procedure. 

 

In case of small slant, it is a good idea to use the up-down button at the 

bottom of the Sync window. Click on the View menu, select Always 

show RX viewer, push the up-down button with looking at the slant of 

the image. 

 

When you have obtained the successful adjustment and want to use it as the default frequency, push the Mem button; otherwise 

MMSSTV applies the adjustment to the current image only. 

 

* If you turn the RX buffer off, you cannot redraw the picture after adjusting the slant. 

High-accuracy slant adjustment and Automatic slant adjustment analyze the timing of the received signal to automatically adjust the 

slant. They, however, might not work well in the situations of QRM, multipath, or weak signals. 

 

The adjusted clock timing is applied only to the current image; it is not memorized in the MMSSTV. If you want to keep the timing 

adjusted, push the Mem button. The adjusted timing is used for all the images afterwards.  

Receive history  
 

MMSSTV can store up to 32 received images in default. 

To increase or decrease this number, click Option, select 

Setup, click Misc tab, and change the value in the 

History max box.  

If the number of stored images would exceed the 

specified value, the oldest image is erased in an FIFO 

manner. 

 

It should be noted that one image requires about 200KB 

disk space, and thus 256 images require about 50MB. 

Pay attention to the disk space of your PC. 

 

To reduce the disk space, you could use the JPEG 

format. Click the picture with the right button of your 

mouse and select Use JPEG format in the pop-up menu. 

 



 

The RX history is only used for a temporary buffer.   The old pictures will automatically be deleted. If you want to keep them, right 

click and check the auto copy to another folder.  

 

With this automatic copy function turned on, MMSSTV records the index into the QSL field of the log so that it can retrieve the picture 

later. 

 

To manually copy the history picture to another folder, drag and drop the picture in the history window to the QSL box in the log 

window. To use this function, you must define the name of the target folder in advance. 

 

MMSSTV automatically records the index in the QSL field of the log, either if the auto copy is turned on or if the history image is 

dropped in the QSL box. Using the MMSSTV log facility, you anytime can refer to the image by pressing the Image button. 

Transmit  

Image Preparation 

There are several ways to prepare the TX image. 

 

1. Drag & drop an image from the stocked picture gallery at the bottom in the main window to the TX window. 

2. Drag & drop an image from the thumbnail window of the folder (View -> Always show thumbnails of files folder) to the TX 

window. 

3. Drag & drop an image from Windows file manager (Explorer) to the TX window. 

4. Drag & drop an image from another image manipulation tool that supports Drag&drop to the TX window. 

5. Copy & paste an image from another image manipulation tool to the TX window through the Windows clipboard. 

 

You can make the TX image superimposed with a template. The template operation is explained in the later section of this document. 

 

Click the TX image with the right button of the mouse to get a pop-up menu that facilitates image manipulations, such as file load and 

save. Drag & drop from Internet Explore is also supported. 

Mode Selection 

SSTV modes 

 

MMSSTV supports the following SSTV modes. 

  Mode  
Duration 

(sec) 
Size   Method 

  -------------------------------------------------------------------------------------- 

  Robot 36 36 320x240 Color differentiation 

  Robot 72 72 320x240 Color differentiation 

  AVT 90 90 320x240 RGB (no synchronization pulse involved) 

  Scottie 1 110 320x256 RGB 

  Scottie 2 71 320x256 RGB 

  Scottie DX  269 320x256 RGB 

  Martin 1 114 320x256 RGB 

  Martin 2 58 320x256 RGB 

  SC2-180 182 320x256 RGB 

  SC2-120 122 320x256 RGB 



  SC2-60 62 320x256 RGB 

  PD50 50 320x256 Color differentiation 

  PD90 90 320x256 Color differentiation 

  PD120 126 640x496 Color differentiation 

  PD160  161 512x400 Color differentiation 

  PD180 187 640x496 Color differentiation 

  PD240 248 640x496 Color differentiation 

  PD290 289 800x616 Color differentiation 

  P3 203 640x496 RGB 

  P5 305 640x496 RGB 

  P7 406 640x496 RGB 

Transmission  

Adjust Tx slant 

Adjustment of the slant of the TX image 

 

Some soundcards (especially PCI form factors') have slightly different frequencies for recording and playing. In this particular case, 

even if you have correctly adjusted the clock in RX, you would have a slant image in TX. 

 

If your soundcard seems to have different clock sampling frequencies for TX and RX, adjust the offset frequency with the following 

procedure. 

 

1) Adjust the slant in RX. 

2) Go Option, Setup, and TX page. Select External in the Loopback. 

3) Connect the Line-out to the Line-in of your soundcard. 

4) Transmit an image with Martin 1. 

5) You should have an image through the external feedback. 

6) After completing the image receive, go Sync page and adjust the slant. 

        - You could use the High-accuracy slant adjustment. 

        - Do not push the Mem button 

7) Push the TX (TX offset) button in the sync page. 

8) Make sure that you have no slant in the TX. If you still have  

slant, repeat from (6). 

 

It is a good idea to use the High-accuracy slant adjustment at Step 6. If you are not satisfied with the result, start it again.  

0ever push the Mem button at this step. 
 

You can use the LoopBack function of a mixer program instead of using the external feedback line. 

 

Although this procedure can be applied only for the soundcard that supports the full-duplex mode, for soundcards that do not support 

the full-duplex mode, should not have different frequencies for TX and RX, and therefore you do not need this calibration. 

 

If you have a report that your TX image is greatly slanted, try changing the soundcard modes, monaural or stereo (Source in the Misc 

window of Setup MMSSTV). 

 

Some soundcards seem to use different sampling frequencies for the full-duplex and not-full-duplex operation. 

In such a case, the offset calibration using the external loop back does not help. You should always have the loop back External or 

consult the QSO report. 



Tune button and CWID 
 

For repeaters in US, MMSSTV has a tone generator. Push the Tune button to transmit a 1750Hz tone. 

 

You can send a CWID after the TX completion. Go OPTIONS > SETUP > TX > then select CW. 

 This is for a European friend of mine. 

 

 

  Template 

   Using a template, you can make a simple picture, 

which is 

   superimposed to the TX image. For example, 

you can use a 

   macro command that puts his/her call sign on the 

TX image. 

 

   MMSSTV provides primitive image-

manipulation functions, 

   but has no support for the group operations now. 

 

 

 

   Make picture items using the tool buttons at the bottom of the 

   window. From left to right they are: 

 
 

- Arrow button Turn on/off the selection mmode 

- Line button Draw line  

- Square button Draw rectangle 

- Shaded square button Draw rectangle with color pasted 

- T button Draw text 

- Picture button Insert picture or history image 

- Color bar button Draw color bar 

- Draw text from defined list 

- Scissors button Cut the item 

- Paste button Paste the item 

- Color palette button Change the color 

- L button Change the property of the seleected item  

- f button Change the font 

 

To use a macro text, for example, push T button and then click the point in the window where the text is placed. The text input dialog 

box is displayed. Push Macro button and select %c to place his/her callsign there. 

 

To move the item, push Arrow button and use drag&drop it. 

 

Here I do not cover all the operations, but they are similar to the DRAW software. Give it a try by yourself. 

 

* You can use drag&drop to copy an image (BMP or JPG) from a file manager (e.g., Explorer) to the template box. 



Superimpose the template over the TX image 
 

When you use a template, MMSSTV superimposes all the colors except a transparent one in the template over the TX image. The 

default transparent color is defined at the bottom right position of the template window. You can change the position by right clicking 

at the arbitrary spot in the window. However, you must click the spot where no template item resides in. 

 

Special care should be taken if you place a template item at the bottom right of the window. 

 

In version 0.21 or later, the function that automatically replaces the transparent point is default ON. Therefore, the transparent point is 

automatically moved to where no template item exists. 

 

You can use any color as the transparent (background) color, but you must choose the color that you do not use in the template. 

However, a color bar and an image are the exceptions. In other words, you even can choose a color that is used in a color bar or an 

image as a transparent one. 

 

* You can settle a background color that is not used in the template by right clicking on the template and selecting "find unique 

background color." 

 

If you want to create or edit the TX picture during the QSO, I would recommend you use other editing software programs, which have 

excellent capability in manipulating images. 

 

The template of MMSSTV is supposed to offer the macro functions, such as his/her call sign, RSV report, and contest numbers. 

Therefore, you would not find good reason to use templates if you do not use the logging function. 

Stock Area 

MMSSTV has a stock area, which can stores up to 300 images. Each stocked image has the image data and the template information. 

To manipulate the clipboard, save and load files, click the stock image with the right 

button of the mouse. You will have a popup menu.  

 

 

To save the disk space, you can use the JPEG format for the stocked images. 

Right click the image and select Use JPEG format in the pop-up menu. 

 

It is a good idea to make a template picture in association with the TX image in advance. 

The stocked area can store the images and the templates independently. However, if you 

use drag&drop to copy the stock image to the TX window, MMSSTV copies the 

associated template, too.  

This is effective only if the Show superimposed templates box is checked. 

If the box is not checked, MMSSTV copies the image and the template independently. 

 

The following table shows how MMSSTV performs the drag&drop operation. 

 

 

[Show superimposed templates ON] 

 

From To Action 

------------------------------------------------------------------------ 

 

Stocked image TX window Copy the image and template 

Stocked template Template window Copy the template only 

TX window Stocked image Copy the image and template 

Template window Stocked template Copy the template only 



 

 

[Show superimposed templates OFF] 

 

From To Action 

------------------------------------------------------------------------ 

 

Stocked image TX window Copy the image only 

Stocked template Template window Copy the template only 

TX window Stocked image Copy the image only 

Template window Stocked template Copy the template only 

 

You can drag & drop an image from Explorer or My Computer to the stock. 

 

It takes substantial time to make the text change in effect in the template. For this reason, the window redraw is slowed down during 

superimposing of the template in the stocked image area. If you do not like it, try checking off Show superimposed templates or 

checking on Draft. In addition, the JPEG format will require a little bit longer time to re-read the file. 

 

* If you get the thumbnail window of the folder displayed on the stocked images window, MMSSTV will use the thumbnail window on 

behalf of the stocked image window. MMSSTV temporarily hides the thumbnail window when you switch to the stocked template 

window. 

Picture Size and Header 

The number of scan lines in the Robot and AVT modes is 240. On the other hand, that in the Scottie and Martin modes is 256. This 

difference is due to the domestic TV modes on which the SSTV modes are based. Robot and AVT were devised in the US and defined 

to have 240 scan lines after the NTSC. Scottie and Martin were devised in the UK and defined to have 256 scan lines. My guess is that, 

to make them compatible to Robot and AVT, the first 16 lines are used for the header that has no picture data. When the receiver uses a 

scan converter and an NTSC TV set, he/she should see only the 240 scan lines on the TV set. 

 

I think, however, the 16 lines make no sense in the SSTV using PC. The 16 lines could have some information on the sending picture. 

 

MMSSTV allows users to define the header (16 scan lines) by using the template item. The following TX modes are supported. 

 

----- Raw picture has 240 lines; the SSTV mode has 256 lines  

(e.g., Scottie) 

1) Define the header in the template. 

2) Push "Shift picture for the header color bar" button to shift  

down the raw picture. 

or 
2) Preserve the upper margin in the picture clipper and copy it to  

the TX window. 

 

----- Raw picture has 256 lines; the SSTV mode has 256 lines  

(e.g., Scottie) 

You can put a header to the first 16 lines, or you put no header. Either is OK. Bear in mind, however, that some receivers/converters 

will not be able to display the first 16 lines. 

When you use the header, you could push the "Adjust picture for the header color bar" button in the TX window so as not to get the raw 

picture hidden behind the color bar. In this case, the aspect ratio of the raw picture is changed. 

 

----- Raw picture has 240 lines; the SSTV mode has 240 lines  

(e.g., Robot) 

MMSSTV transmits the image without a header. 

 

----- Raw picture has 256 lines; the SSTV mode has 240 lines  



(e.g., Robot) 

1) Define the header in the template. 

2) Push the "Shift picture and template for 240 line mode" button to 

shift up the raw picture and the template. The upper 16 lines of 

the raw picture are not transmitted. 

or 
Define the template without a header. The lower 16 lines of the 

raw picture are not transmitted. If you push "Adjust picture and  

template for 240 line mode" button, you do not lose the lower 16  

lines but the aspect ratio of the picture is changed.  

 

Program menu 
 

With the program menu, you can instantly start your favorite programs, such as an image manipulation tool, PSK31, RTTY, and 

MFSK16 programs. Here is what the menu looks like when you click on programs....  

 
 

 

 

 

 

 

 

 

 



If you check Suspend box in the Assign menu, MMSSTV automatically goes down to the suspended state and starts the selected 

program. In this state, MMSSTV has released the COM and soundcard resources in order to allow the other program to use them. To 

restart MMSSTV, first terminate the program and then click the MMSSTV icon in the Windows task bar.  

 
 

When you want to start the program that is not assigned to the MMSSTV program menu, you can select Suspend in the Program 

option. MMSSTV will release the hardware resources of the COM and soundcard and make itself iconized. 

 

If you wake MMSSTV up again while the other program that uses the COM and soundcard resources is running, MMSSTV would 

show an error message. In this case, MMSSTV will not be iconized again. To resume MMSSTV, terminate the other program and wake 

MMSSTV up again, or select Restore in the Program menu. It is greyed out here but once you have a program running it will be 

available.  

 
 

* You do not have to check Suspend for an image manipulation tool, because it typically does not use the COM or soundcard. 

 



Vari SSTV   

VariSSTV, which is proposed by Mr. Samuel Hunt, is a method to protect the final device of the TX. He says that different colors have 

different brightness and therefore making the power lower in the way shown below gives better noise immunity. 

  Sync signal 100% 

  Red 29.8% 

  Green 58.8% 

  Blue 11% 

I have no idea how it is effective.  

Please give it a try by yourself. 

 Go Option, Setup MMSSTV, TX tab, and check the VariSSTV box under the digital output level slider. This is not operational in 

Robot36 or Robot72. 

 Demodulator  

This section describes the digital signal processing used in MMSSTV. Refer to Digital.Txt of MMTTY for basic DSP operations. 

 

MMSSTV has three types of demodulators. 

 

(1) Demodulator configuration 

 

MMSSTV's demodulator has the following configuration. 

 

Sound --> BPF (FIR) --+> BPF1100 (IIR) --> VIS symbol '1' 

| 

+> BPF1300 (IIR) --> VIS symbol '0' 

| 

+> BPF1200 (IIR) --> Sync 

| 

---> Zero cross det. (1500 to 2300)--> Picture data 

or 

| 

---> PLL(1500 to 2300) --> Picture data 

or 

| 

---> Hilbert(1500 to 2300) --> Picture data 

 

The zero cross detector's configuration is 

 

---> Differentiator ---> Counter ---> Out LPF ---> Pic. data 

 

The next figure shows the PLL configuration 

 

---> Phase det. ---> Loop LPF ----> Out LPF ----> Pic. data 

| | 

<---- VCO <------------- 

 

The next figure shows the Hilbert transform configuration. I got this idea from JA6UHL Nishimura-san (MNI TNX to JA6UHL). 

 

--+-> Delay(N) -> Real 



| |==> ATAN -> Differentiator -> LPF -> Pic. data 

--> FIR(2N) --> Image 

 

According to my experiences, they have the following pros and cons. Please give it a try by yourself to find your favorite method. 

 

Decoder Zero-cross PLL Hilbert transform 

Color accuracy Fair Good Good 

Image resolution Fair Fair Good 

QSB Good Fair Good 

CPU load Low Low High 

Sampling freq. HB* HB* ---------- 

 

*HB: The higher, the better. 

 

In the zero-cross and PLL methods, you can set the cut-off frequency of the OutLPF higher. 

 

In the Hilbert transform, the accuracy of the phase differentiation degrades as the sampling frequency increases. The default sampling 

frequency, 11025Hz, gives better results, though MMSSTV does the decimation to keep the transform accuracy. 

 

(2) Zero cross detector parameters 

 

[Out LPF] 

This filter smoothes the frequency ingredients obtained by the counter. 

 

If you want a sharp image, increase the cut-off frequency. 

If you want a low-noise image, decrease the cut-off frequency. 

You can select an IIR or FIR filter for the Out LPF. However, it seems that they have no significant difference. The FIR filter is better 

for low sampling frequency because it consumes lower CPU power than the IIR filter. 

 

(3) PLL parameters 

 

The parameters of the PLL affect the picture quality. Since the behavior of this PLL is just the same as that of the hardware PLL, try 

adjusting the parameters as you have better results. 

 

[VCO Gain] 

VCO gain strongly affects the response of PLL. Higher VCO gain gives quicker response; lower VCO gain gives slower response. To 

high VCO gain would result in the oscillation of the decoded signal. 

 

[Loop LPF] 

In addition to VCO, the Loop LPF is an important parameter that dominates the loop dumping factor. Always use a one-order filter. If 

you increase the cut-off frequency, the oscillation amplitude of the decoded signal becomes bigger. 

 

[Out LPF] 

The Out LPF filter does not affect the response of the PLL because it sits outside of the loop. It, however, should be noted that it 

strongly affects the picture quality. If you want a sharp picture, set the cut-off frequency higher. If you want a low-noise picture, set it 

lower. Adjust it according to your preference. 

 

 

(4) Differentiator 

 

When the Differentiator box is checked, MMSSTV compensates the LPF effect by boosting the high-frequency ingredient of the 

received image. However, it makes the receive image be more likely affected by the noise. Try adjusting the effect with the slider for 

your preference. As the slider goes right, the differentiator takes sharper effect. 

 

*The differentiator is not related to the differentiator of the zero-cross detector. 



 

 

(5) Level converter 

 

The level converter translates the frequency value derived by the decoder into the color amplitude values. MMSSTV provides two types 

of converters, which can be selected in the RX window of MMSSTV Setup. 

 

- Linear converter (uncheck the polynomial box) 

It assumes that the frequency and the color level are linearly related. It is simple, but the frequency characteristics of the decoder must 

be linear. 

 

- Polynomial converter (check the polynomiaal box) 

It uses a 17-th order polynomial formula for the level conversion. It works better if the frequency characteristics of the decoder are not 

linear. Since the converter uses a pre-calculated table to boost the processing speed, it should not require much more CPU load. 

 

It is a good idea to use the polynomial converter for the 11025MHz zero-cross detector because it has a little linearity problem in 2200 

to 2300Hz. As the sampling frequency goes higher, the decoder will have better linearity. However, even in 11025Hz, the conversion 

error is 2/256 - 3/256, and therefore the error might not be visible. 

 

MMSSTV starts the automatic calibration by pressing the calibration button in the RX window of MMSSTV Setup. It takes about 20 

seconds. 

After the calibration, MMSSTV shows the frequency characteristics figure. If the line of the figure goes straight down to the right,  

you can uncheck the polynomial converter (you can use the linear converter). 

 

=============== 

Profile 

=============== 

The default demodulator parameters are settled according to my experiments, which, however, are very limited. I have had no sufficient 

time for the parameter optimization. If you are a master of SSTV, you already have found good parameters. 

 

With the Profile function, you can easily save and load up to 8 sets of the demodulator parameters. Each set can be named, as you like. 

 

It is a good idea to save your favorite demodulator parameter set as MyDefault before you try many different parameters. If you got lost 

in the parameter setting, you will be able to step back to the start point. 

 

MMSSTV has a special profile "MMSSTV Default," which cannot be modified by the user. This is the MMSSTV default parameter 

set. 

* It should be noted that the Profile memorizes the demodulator parameters only.   

 Filters 

Receive Filters 

Supplemental RX filters 

 

MMSSTV has two supplemental RX filters. 

 

Sound ---> LMS ---> BPF (FIR) ---> Demodulator 

 

[LMS] 

It is an adaptive filter based on Leaky LMS (Least mean Square) method. It can be turned on/off using the LMS button in the main 

window. It intentionally uses low number of taps so that it does not cause the image drift when it is turned on and off even during the 

RX operation. For this reason, it does not have strong noise reduction, but it sometimes works FB between QSB. Since LMS 

emphasizes the signal that has strong correlation with the past signals, it might be ineffective or get QRM worse for single beat QRM. 

 



[BPF] 

It is a simple FIR band-pass filter. You can choose the sharpness in the RX page of the setup MMSSTV menu. As it is sharper, it is 

more likely to exclude adjacent QRMs, but on the other hand it degrades the horizontal resolution. It should be noted that you will have 

the RX image drifted if you change the sharpness during the RX operation. This is because each selection has different delay time. 

Transmit Filters 

TX filter 

 

MMSSTV generates the TX signal with the flow shown below. 

 

Picture data ---> LPF ---> VCO ---> BPF ---> D/A ---> Sound data 

ON/OFF ON/OFF 

 

LPF and BPF are used to limit the frequency of the digital output as insurance. If the CPU load is too high for TX, you can turn them 

off. However, I strongly recommend that you turn the BPF on when you use CWID. 

 

[LPF] 

This filter smoothes the signal translation from the image to the frequency domain. As a result, the frequency bandwidth is substantially 

limited and the horizontal resolution of the TX image is slightly sacrificed. 

 

[BPF] 

This filter limits the bandwidth of the TX signal. It is useful to limit the spectrum spread for CWID. 

 Sampling Frequency 

MMSSTV has an option that allows the following sampling frequencies: 

 

8000 Hz Secondary standard frequency 

11025 Hz Primary standard frequency 

12000 Hz 

14000 Hz 

16000 Hz 

18000 Hz 

22050 Hz Primary standard frequency 

24000 Hz 

44100 Hz Primary standard frequency 

 

You will have better quality in the RX images by increasing the sampling frequency and setting the cut-off frequency higher in the 

zero-cross and PLL decoders. In the Hilbert transform decoder, on the other hand, I recommend the default sampling frequency 

11025Hz. 

 

It should be noted that not all the soundcards support the frequencies listed above all. All the soundcards, however, should support 

11025Hz, 22050Hz and 44100Hz. In addition, the high frequency dissipates more CPU power and more memory space. 

 

 

Tips: 

* MMSSTV always calculates the FFT with 2048 points. To obtain the proper frequency resolution, MMSSTV uses a half frequency 

for FFT in case the sampling frequency is 18000Hz or higher. In the same manner, MMSSTV uses a quarter frequency in case of 

44100Hz.  

  



Clock Calibration 

In SSTV, the discrimination of the clock appears as a slanted image. For MMSSTV, you are not required to have the absolute and exact 

clock frequency value (e.g. 11025Hz). But it is important to get MMSSTV informed on what the frequency of your soundcard has. 

 

In normal situations, you would only have to adjust the slant by using the Sync window. If you want to calibrate your soundcard very 

accurately, listen to the standard radio or fax wave. 

 

1) Go Option, Setup, Misc page, and push Adj button. 

2) Receive standard radio wave (e.g., WWV and JJY). 

3) Tune into the tick sound. 

4) Continue listening to the sound for a while.  

You have a vertical line. 

5) Click the upper point of the line. 

6) Click the lower point of the line. 

 

You could use FAX broadcasting instead of WWV or JJY, but be sure it has exact timing. Refer to the MMTTY help for details. 

 

If your soundcard seems to have different clock sampling frequencies for TX and RX, adjust the offset frequency with the following 

procedure. 

 

1) Adjust the slant in RX. 

2) Go Option, Setup, and TX page. Select External in the Loopback. 

3) Connect the Line-out to the Line-in of your soundcard. 

4) Transmit an image with Martin 1. 

5) You should have an image through the external feedback. 

6) After completing the image receive, go Sync page and adjust the slant. 

- You could use the High-accuracy slant adjustment. 

- Do not push the Mem button 

7) Push the TX (TX offset) button in the sync page. 

8) Make sure that you have no slant in the TX. If you still have  slant, repeat from (6). 

 

It is a good idea to use the High-accuracy slant adjustment at Step 6. If you are not satisfied with the result, start it again. Never push 

the Mem button at this step. 

 

You can use the LoopBack function of a mixer program instead of using the external feedback line. 

 

Although this procedure can be applied only for the soundcard that supports the full-duplex mode, the soundcard that does not support 

the full-duplex mode should not have different frequencies for TX and RX, and therefore you do not need this calibration. 

 

If you have a report that your TX image is greatly slanted, try changing the soundcard modes, monaural or stereo (Source in the Misc 

window of Setup MMSSTV). 

 

Some soundcards seem to use different sampling frequencies for the full-duplex and no-full-duplex operations. 

In such a case, the offset calibration using the external loop back does not help. You should always have the loop back External or 

consult the QSO report.  

   

 

 

 



 

 

Repeater Mode 

2001.9.11 JE3HHT Makoto Mori 

Translated into English by JA7UDE Oba 

 

Run MMSSTV as a repeater 

 

To run MMSSTV in the repeater mode, add "-r" option: 

 

MMSSTV.EXE -r  What that means is right click on the MMSSTV icon on your desktop. Choose properties, then put the  -r after the " 

. 

Make sure there is one space after the " then put -r. See the picture. 

 

While MMSSTV is running in the repeater mode, all the standard 

functions are still operational. Enjoy SSTV as you usually do. 

 

If you want to add your call sign and/or the time stamp to the 

beacon or replay pictures, use templates. You can specify various 

templates for these purposes. 

 

You can change the transmission mode of the replay picture in 

accordance with the mode of the received picture. Uncheck "Fixed 

mode" in the TX tab of the MMSSTV Setup Option. MMSSTV 

uses the same mode as the received picture. 

 

It is recommended to use Hilbert transform for the FM 

demodulator for better image quality. Turn on or off "Auto stop," 

"Auto restart," and "Auto resync" options as you prefer. 

 

 

Introduction of the repeater function 
 

MMSSTV repeater function works as follows: 

 

1. MMSSTV returns CW ID after receiving a tone signal. The 

default frequency of the tone is 1750Hz. 

2. When MMSSTV starts receiving a picture in the specified time 

(default is 10 seconds) after the CW ID, it receives and         

resends the picture. 

3. MMSSTV optionally sends a beacon picture periodically. 

 

MMSSTV keeps watch on the squelch status before starting the TX operation. When the squelch is open, MMSSTV will not start TX.  

Squelch 

 

Squelch works as follows: 

 

1. Cancel the CW ID response If the squelch is not closed 10 seconds after the detection of  the access tone, MMSSTV cancels the tone 

detection and  

will not transmit the CW ID. 

 



2. Cancel the replay picture If the squelch is not closed 20 seconds after the picture received, MMSSTV will not replay the picture. 

 

3. Suspend the beacon If the squelch is opened in the period of "Silence time," MMSSTV postpones the beacon transmission. In other 

words, MMSSTV does not send the beacon at least the band is continuously clear for  "Silence time." 

 

The repeater would cause QRM. The beacon in particular is automatically transmitted without notice, and thus it is likely to cause 

QRM. Pay special attention to the squelch threshold (do not set it too high). 

 

 

Setup repeater options 
 

Click on "Option" and select "Setup repeater" to 

open the repeater setup window. 

 

If you have changed the following options, you 

must click the OK button to make them take effect. 

 

[Enabled] 

Check this box to enable the MMSSTV repeater 

function. 

 

[SQ level] 

This specifies the squelch level of the auto-

correlator. When the output level of  

the auto-correlator exceeds this threshold, 

MMSSTV does not start TX. If you  

put 0 to SQ level, the auto-correlator is turned off 

and MMSSTV will start TX irrespective of the RX 

signals.  

THIS IS NOT RECOMMENDED, HOWEVER. 

 

Debug pane displays the output level of the auto-correlator. Seeing the pane, put an appropriate value, which should be slightly higher 

than the noise level, to the SQ level box. It should be noted that MMSSTV never starts TX when it is receiving a picture. The auto-

correlator will not work while MMSSTV is receiving a picture. 

 

 

[Answer] 

Put the CW ID, which MMSSTV transmits in response to the tone signal received, to this box. The frequency and speed of the CW ID 

are specified in the MMSSTV Setup window. 

 

[Tone] 

Tone frequency for accessing the repeater. The default is 1750Hz, but you have to use a different frequency if you have another 

repeater on the same channel. The tone frequency is displayed as a dotted line in the spectrum window. 

 

[Tone det.] 

Tone detection time (msec). To access the repeater, you have to continuously transmit the access tone for at least the time period 

specified here. 

 

[Answer wait] 

Wait time (msec) for CW ID. When MMSSTV detects an access tone, it waits for the time specified here and then starts transmitting 

the CW ID. 

 

[RX timeout] 

Time out time for receiving. If MMSSTV does not receive a picture before the timer expires, MMSSTV goes back to waiting state. 



 

[Replay wait] 

Wait to for the replay. MMSSTV waits for the time specified here after the completion of RX, and then it starts the replay TX 

operation. 

 

[Tone sensitivity] 

Tone detection sensitivity. Highest is the most sensitive, Lower is the least sensitive. 

 

[Folder] 

If you specify a folder name here, the TX pictures are automatically saved in the folder. The folder must pre-exist. The pictures are 

stored in the JPEG format. 

 

[Template No.] 

Select the template numbers for replay and beacon pictures. Template number 0 inhibits the template loading. 

 

In the repeater mode, MMSSTV displays a small number at the top left corner of each picture in Stocked pictures and Stocked 

templates window. 

 

You can use multiple selections for Template No. In this case, MMSSTV uses the templates in the specified order. 

 

Example: 25,26,27 - Use Template 25, 26, 27, 25, 26, 27, .... 

 

For the beacon pictures, you can add # in front of the number to send the stocked picture of the same number, with the template 

superimposed. 

 

Example: 26,#27,26,#28 - 27 and 28 are sent with 27-th and 28-th pictures, respectively. 

 

If you do not add #, the beacon pictures are loaded from the latest four pictures in the history.  

 

If you do not want to use a template, specify a number of any empty templates. 

 

[Beacon-Interval] 

Beacon interval. "OFF" disables the beacon.  

The timer is reset if MMSSTV receives a picture. 

 

[Beacon-Silence time] 

MMSSTV keeps watch on the frequency for the specified time before  

transmitting the beacon. 

 

[Beacon-SSTV MODE] 

SSTV mode for the beacon picture. 

 

[Beacon-Use image filter] 

When the beacon pictures are composed from the latest four images  in the history, you can use an image filter. The filter slightly 

degrades the image resolution, but it dissolves the folding error caused in the scale-down operation.  

 

[Beacon button] 

Send the beacon immediately. 

 

 

Debug pane 
 

The debug pane displays the following values for supervising the repeater operation. 

 

 



State: 

0 - Waiting for the access tone 

1 - Detected the access tone 

2 - Waiting for the CW ID transmission 

5 - Waiting for the picture receive 

6 - Receiving the replay picture 

8 - Waiting for the picture transmission 

10 - Transmitting the replay picture 

 

Ans: Number of CW ID transmitted 

RX: Number of pictures received 

TX: Number of pictures transmitted 

Level: Output level of the auto-correlator 

Beacon: Number of beacons transmitted and the beacon timer value 
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[FIFO] 

FIFO specifies the number of the buffer for the low-level sound processing. As the number is increased, the possibility of timing loss is 

decreased because of larger sound processing margin. Enlarge the RX-FIFO if you lose the timing in RX. Enlarge the TX-FIFO if you 

lose the timing in TX. 

 

[Priority] 

Priority defines the task priority for low level sound processing.  If you lose the sound during RX or TX, raise the priority. If the 

response of the menu operations is slow, lower the priority. Normal is the lowest and Critical is the highest priority. 

 

[DeviceID] 

DeviceID specifies the ID number of the sound card. When you have only one sound card, put -1 or 0 to DeviceID. -1 uses the default 

sound card. The sound card IDs are sequentially assigned as 0, 1, 2, .... When you have two sound cards, for example, and want to use 

the second one for MMSSTV, put 1 to DeviceID. 

 

[Source] 

Source defines the channel of the sound card. Mono makes the sound card work in the monaural mode. Left or Right makes the sound 

card work in the stereo mode and uses one of the channels. In TX, MMSSTV outputs the sound to both channels irrespective of the 

Source setting. 

 

[Clock] 

Clock is the sampling frequency of MMSSTV. Refer to Sample frequency and Clock calibration sections.  

   

 

 

 

 

 

 



Closing Remarks 

MMSSTV is a freeware program for amateur radio use. You can redistribute it as you like. Please join the following reflector for 

detailed information, 

 

http://groups.yahoo.com/group/MM-SSTV  

Also the website for MMSSTV is ... 

http://amateur-radio.ca 

 

The JPEG converter in MMSSTV is based on the freeware source code, "IJG code," provided by Independent JPEG Group. 

 

 

73 de JE3HHT Mako 

These HTML files are copyright Andrew Eaton VE8AE. If you would like to use them please just email me at 

antennas@yahoo.com for permission. Normally it will not be a problem. Thanks to all who helped!! 

73  de  VE7REF ( VE8AE)  Andrew 

 

I tried several times to contact Andrew at the email address provided but never received a reply. He had set up this help on a Geocities 

website. I salvaged this information from archives of the now defunct Geocities site.  

(Geocities shut down all sites in October 2009.)  

Thanks to The Wayback Machine - http://www.archive.org for making this possible. 

 

73 ....... Ken - VE5KC (Webmaster) 



 


